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1. Introduction 

 
The TC-PRISMA software is a general computational tool for simulating kinetics of diffusion 
controlled multi-particle precipitation process in multi-component and multi-phase alloy systems. 
Precipitation, formation of particles of a second phase or second phases from a supersaturated solid 
solution matrix phase, is a solid state phase transformation process that has been exploited to 
improve the strength and toughness of various structural alloys for centuries. This process is 
thermochemically driven and fully governed by system (bulk and interface) thermodynamics and 
kinetics. Typically, a precipitation process has three distinctive stages: nucleation, growth, and 
coarsening. However, under certain conditions, they could happen also at the same time. With TC-
PRISMA, the kinetics of concurrent nucleation, growth, and coarsening can be simulated by 
calculating the evolution of the probability distribution of the particle number densities, usually called 
particle size distribution (PSD). The simulation results can be used to understand and guide how to 
obtain desirable precipitates with certain PSD or to avoid undesirable precipitations during heat 
treatments of alloys such as aging and tempering. A summary for the input and output of TC-
PRISMA is shown in Figure 1.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 1 Input and output of TC-PRISMA. 
 
 
TC-PRISMA relies on CALPHAD based software tools and databases to provide necessary bulk 
thermodynamic and kinetic data for phases in multi-component systems. The CALPHAD approach 
has been developed for more than 50 years and is now routinely applied to design new alloys and 
optimize existing materials within various metal industries, such as steels and alloys of nickel, 
titanium, aluminum, and magnesium. The power of this approach is due to the adopted methodology 
where free energy and atomic mobility of each phase in a multicomponent system can be modeled 
hierarchically from lower order systems, and model parameters are evaluated in a consistent way by 
considering both experimental data and ab-initio calculation results. TC-PRISMA is directly 
integrated with Thermo-Calc and DICTRA, which are CALPHAD based computer programs for 
calculating phase equilibrium and diffusion controlled phase transformation in multicomponent 
systems and have a wide spectrum of accompanying thermodynamic and kinetic databases. With 
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 Alloy composition 
 Temperature 
 Simulation time 
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Output 
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 Average particle radius 
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 Critical radius 
 TTP diagrams 



Thermo-Calc and DICTRA and accompanying databases, almost all fundamental phase equilibrium 
and phase transformation information, such as driving forces for nucleation and growth, operating 
tie-line under local equilibrium or para-equilibrium condition, deviation from local equilibrium at 
interface due to interface friction, atomic mobilities or diffusivities in the matrix phase etc., can be 
calculated without unnecessary and inaccurate approximations. 
 
In addition to bulk thermodynamic and kinetic data, a few other physical properties, such as 
interfacial energy and volume, are needed in precipitation models implemented in TC-PRISMA. 
These additional physical parameters can be obtained by experiments or other estimation models or 
first principles calculations. As a matter of fact, volume data for steels and nickel-based alloys has 
already been assessed and included in TCFE6, TCNI5, and TCAL2 databases.  It is hoped that in 
future interfacial energy can also be modeled in the spirit of CALPHAD method and the model 
parameters can be assessed by considering various kinds of experimental data with help of TC-
PRISMA.  
 
In this document, we show how to operate the TC-PRISMA software and describe various 
theoretical models and numerical algorithms that has been implemented in the software. Chapter 2 
gives a short instruction on how to perform a TC-PRISMA simulation right away. The Graphic User 
Interface (GUI) is described in Chapter 3 and various windows are introduced one by one following 
the main procedures of a fresh simulation. Chapter 4 covers the precipitation models and numerical 
method. Detailed description of physical and numerical parameters can be found in this chapter. 
Simulation examples are summarized in Chapter 5. 
 

1.1 Version History 
 

 TC-PRISMA version 1.0 and 1.1 treat isothermal precipitation process.  

 TC-PRISMA version 2.0 enables arbitrary temperature-time profiles, especially continuous 

cooling conditions. For the convenience of users, interfacial energy between matrix and 

precipitate phases can be estimated in this version by using an approximation model based 

on Becker’s bond energy approach. 

  



2. Quick Start 

 
Once TC-PRISMA is installed, it would be good to start by running a few examples first and confirm 
that the installation is successful. Afterwards, you can try to perform simulations for your own alloys 
of interest. Some examples may not work due to that commercial databases are used in these 
examples and the access to these databases requires a valid license, which unfortunately cannot be 
found on your computer. Examples 5.1, 5.2.1, 5.3.1, 5.3.2, 5.5, and 5.6 need no commercial databases 
and should always be possible to run. 
 

2.1 Run Examples 
 
Examples can be found by clicking "File -> Open Script" or the open file icon. A macro file (with 
extension PRM) for each example in the corresponding folder can be loaded for setting up the 
simulation task. If everything is OK, the Simulate button at the lower right corner will then be 
activated. Click the button, and the simulation will start. For some examples, experimental data is 
collected from publications and can be compared against the simulation results by clicking “Format 
figure -> Add experiments”. Time and length units can be changed by clicking “Format figure -> 
Time units” and “Format figure -> length units” respectively in order to make proper comparisons. 
A description of all examples is given in Chapter 5 - Examples. 

 

2.2 Make a New Simulation 
 
To perform a simulation for your own alloy, you can try by copying an example script file to a new 
folder and making necessary modifications to the script or alternatively by starting from scratch and 
going through the following steps (see Figure 2). When starting from scratch, it is advised to save 
your setup to a script file and, during the “save script” operation, select always a different folder or if 
necessary, make a new folder in order to avoid existing files being overwritten or output files being 
mixed up when running several simulations at the same time. 
 

  Define System: Choose a database package, select elements, select matrix phase, and select 
precipitate phase(s). 

  Set Simulation Conditions: Activate the CONDITIONS panel, enter thermal profile, and 
enter matrix composition.   

  Set Nucleation Properties: Click Properties button to get the Nucleation window, select 
nucleation site and enter necessary microstructure information in the case a heterogeneous 
nucleation site is selected. 

  Set Parameters: Enter interfacial energy, volume data, etc. if they are not available from the 
databases used. The Set Parameters window can be accessed by clicking “Data -> Set Parameters”. 

  Simulate 

  Plot results 
 
 
 



                              
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2    How to start a simulation from scratch. 
 

 

2.3 Work with Different Types of Files 
 
TC-PRISMA has following types of files: 
 

 PRP file – Database list file or database package configuration file. Be careful when trying to 
modify these files. Make sure that added databases are actually available on your computer. 
Corrupted PRP file may cause the TC-PRISMA software not able to start. 

 PRM file – Macro file.  

 PRI file – Workspace file. A binary file storing everything. It can be loaded for reviewing 
simulation results. 

 PRD file – Result data file. 

 
 

Set Nucleation Properties 

 Define System 

 Set Simulation Condition 

 

 Set Parameters 

 Simulate 

 Plot Results 



3. Graphic User Interface 

TC-PRISMA offers a user friendly and intuitive Java-based Graphic User Interface (GUI). With only 
a few clicks and inputs, a simulation can be setup and performed. After the simulation is completed 
the results can directly be plotted and compared with pre-compiled experimental data. The obtained 
figures can be edited, printed, and saved into different graphic format.  
 
We now give an introduction to all major features of the GUI. It is believed that most of the menus, 
buttons, and boxes are self-evident, and here we focus only on a few most important ones.  

3.1 Define System  
 
The startup window allows one to choose between a simulation with CALPHAD database input and 
one with user input binary data. Depending on this choice, either SYSTEM tab or BINARY tab will 
show up and allow you to define your system accordingly. 

3.1.1 CALPHAD Database Calculation 
 

 
With the SYSTEM tab, one can 

 Select a pre-defined database package from the drop down list of available packages. A 

package consists of three compatible databases, one for thermodynamic data, one for kinetic 

data, and the other for properties, such as interfacial energy. The user can define a new set of 

database packages (see Section 3.8). 

 Add elements. 

 Choose a matrix phase. 

 Add precipitate phase(s). Maximum 5 different phases are allowed. 

 



3.1.2 User Defined Binary Calculation 
 

 
With the BINARY tab, one can provide all necessary information including element, phase name 
(any name can be used), phase diagram (solvus line), kinetics (diffusivity), volume of different phases, 
interfacial energy, etc. More than one tab for precipitate phases can be added by clicking “+”. 

3.2 Set Simulation Condition 
 
After your system is defined in either way by using database or user-input binary data, you can click 
and activate the CONDITIONS tab. Here materials chemistry, thermal profile (temperature and 
time), nucleation properties can be specified. Two types of calculations are allowed, one for a single 
thermal profile simulation, and the other for a TTT calculation. When all are set a simulation can be 
started by pressing the Simulate button.  

3.2.1 Single Thermal Profile 
 

 



Here one needs to specify heat treatment schedule and alloy compositions. One needs also to set the 
nucleation properties (see Section 3.3) by pressing the Properties button and perhaps some physical 
parameters (see Section 3.4) if, for example, there is no interfacial energy or volume data available in 
the database package.  
 
Heat treatment schedule can be defined by pressing the Thermal Profile button, which brings up 
the Thermal Profile window. Here the time and temperature coordinates of thermal profile points 
can be entered. A minimum of two points is required to set up a thermal profile.  
  

3.2.2 TTT Diagram 
 

 
Everything is the same as for a single thermal profile calculation except that one has to specify a 
temperature range and a phase fraction for the precipitate phase. 
 

3.3 Set Nucleation Properties 
 

 
By pressing the Properties button on the CONDITIONS tab, one gets a pop-up Nucleation 
window, where one specifies the type of nucleation site and the available number of it. For grain 
boundaries, edges, and corners, the grain size and aspect ratio of the matrix phase have to be given. 



For dislocations, the dislocation density has to be specified. Unchecking “Automatic calculation of 
nucleation sites”, one can enter a specific value for the number of nucleation site instead of 
accepting the automatically calculated value. 
 

3.4 Set Physical Parameters 
 

 
 
Click Set Parameters in the Data menu, one can get a pop-up Set Parameters window, where one 
can set the interfacial energy, volume, interface mobility (for considering deviation from local 
equilibrium due to interface friction), mobility enhancement factor (for considering grain boundary 
diffusion etc.), or phase energy addition to the precipitate phase(s) (for altering phase diagram). 
 

3.5 Open and Save Script File 
 

 
TC-PRISMA comes with a number of example scripts that are placed under My 
Documents\Thermo-Calc\TC-PRISMA\examples. Opening a script file, with extension PRM, will 
give a complete setup of a simulation. Any user defined simulation can be save in a script by clicking 
the SAVE button in the top or through the File menu. Click Reinitiate before opening a new script. 

3.6 Open and Save Workspace File 
 
The TC-PRISMA scripts only contain setup for a simulation. The simulation data is saved in TC-
PRISMA workspaces. These are files with the file extension PRI. As a default, all the current 
simulation data is saved in a workspace called TKDATA.PRI. From the File menu one can open 
and save workspaces. 

 Open Workspace. This will open an old workspace and load the data stored in this workspace. 
Click Reinitiate before opening a new workspace. 

 Save Workspace. This enables the user to rename the workspace. Very important: This will 



RESET the workspace and clear all data from it. Save Workspace must be performed 
BEFORE doing any simulations. 

3.7 Reinitiate 
 

 
At the top left of the GUI is the Reinitiate button. This action can also be found in the File menu. 
Clicking this button will terminate the current simulation and restart the program. It is necessary to 
do this before continuing for a new simulation. 
 

3.8 Add a New Database Package 
 

To add a new database package, one can select Edit Database Package from the Data menu.  
Check first if the databases to be included in the new package are actually available in the drop down 

list in each corresponding category by clicking  at the right side of any box. If not, close this 
window, and then select Edit Database List from the Data menu.  From the pop-up Edit 
Database List window, one can select a database and add it to the list of either thermodynamic, or 
kinetic, or property databases by clicking Apply. Close this window, and reopen the Edit Database 
Package window, now one can enter a new package name in the available blank box, and then in the 
same row choose the right database from each category of databases. Make sure that everything is 
correct before clicking Apply. A new database package is then generated and stored, available for 
future uses. 
 
 
 

 
 
One can also add a new database package by directly editing the TKDBPACK.PRP file. One must 
make sure that each database in the new package is available in the TKDBLIST.PRP file. If not, 
please add it to the corresponding category in this file. Be careful that the specified databases should 
be actually available on your computer. Corrupted PRP file may cause the TC-PRISMA software not 
able to start. Therefore, it is always a good idea to keep a copy of the original files. 



3.9 Post Processing of Multi-modal Size Distributions. 
 
When doing non-isothermal simulations it is common that particles grow in different generations. 
This will result in multi-modal size distributions. To correctly estimate the properties of these 
different generations of particles it is possible in TC-PRISMA to separate the peaks of multi-modal 
distributions into separate functions. 
 
This functionality is activated when checking "Separate multi-modal size distributions". When turned 
on, the size distribution will be evaluated at the given time steps and checked for multi-modal peaks. 
These will be separated and used to calculate the specified property. 
 
It can be applied on the following plot properties: 

 

 Size Distribution 

 Mean Radius 

 Volume Fraction 

 Number Density 

 

3.9.1 Input Fields 
 
Number of Evaluation Points. 
Since the evaluation of multi-modality at each time step is costly the user can in this field specify how 
many evaluation points should be used. The points are geometrically distributed over the time scale 
where nucleated particles are found. 
 
Excess Kurtosis for Binomial Split. 
This number specifies the sensitivity when the program evaluates whether a curve is bimodal or not. 
The evaluation process will calculate the excess kurtosis of the given size distribution and compare it 
with the input value. If the value is lower than the given value, the distribution will be split. The 
excess kurtosis is a statistical measure that measures how "peaked" and "how heavy tail" a 
distribution has. For the definition used see http://en.wikipedia.org/wiki/Kurtosis. 
 
Minimum Separation Limit. 
This is a rough method to prevent that noise or wiggles are interpreted as different distributions. If a 
local minima is encountered above this absolute value the following peak is not interpreted as a new 
distribution. 
 
Minimum Distribution Peak. 
Any separated peak below this value is removed.  



4. Theoretical Models and Numerical 

Methods 

4.1 Overview 
 

Based on Langer-Schwartz theory [1], TC-PRISIMA adopts Kampmann-Wagner numerical (KWN) 
method [2] to simulate the concomitant nucleation, growth, and coarsening of precipitates in 
multicomponent and multiphase alloy systems. The KWN method is an extension of the original 
Langer-Schwartz (LS) approach [1] and its modified (MLS) form [2], where the temporal evolution 
of the mean radius and particle density over the whole course of precipitation are predicted by 
solving a set of rate equations derived with certain assumptions for the rates of nucleation and 
growth, as well as the function of particle size distribution (PSD). The MLS approach differs from 
the LS with respect to the Gibbs-Thomson equations used for calculating equilibrium solubilities of 
small particles. The former applies the exact exponential form, whereas the latter takes the 
convenient linearized version. Instead of assuming a PSD function a priori and working with rate 
equations for determining only mean radius and particle density, the KWN method extends the LS 
and MLS approaches by discretizing the PSD and solving the continuity equation of the PSD 
directly. Therefore, the time evolution of the PSD and its n-th moment (0-th: number density; 1-th: 
mean radius; 3-th: volume fraction) can be obtained altogether during the simulation. The key 
elements of the KWN method are the models for nucleation and growth under the mean field mass 
balance condition and the numerical algorithm for solving the continuity equation of the PSD 
(Figure 1). Coarsening will come out naturally without any ad hoc treatment. 
 
 

 

Figure 3 The key elements of the KWN method and their relations as implemented in  
TC-PRISMA 
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TC-PRSIMA is integrated with Thermo-Calc and DICTRA in order to obtain directly all necessary 
thermodynamic and kinetic information required in the KWN method, which has mostly so far been 
applied for binary or pseudo-binary systems where the nucleation and growth rates can be 
approximated quite easily. For industry relevant multicomponent alloys, thermodynamic and kinetic 
databases and calculation tools have to be used in order to obtain various quantities in the 
multicomponent models for nucleation and growth, such as the driving forces for the formation of 
embryos and their compositions, the atomic mobilities or diffusivities in the matrix, the operating 
interface compositions under local equilibrium or para-equilibrium condition, the Gibbs-Thomson 
effect, and the deviation from local equilibrium due to interface friction etc. With Thermo-Calc and 
DICTRA and accompanying databases, all these properties and effects can be calculated without 
unnecessary and inaccurate approximations.  
 
In the following sections, various models and numerical methods implemented in TC-PRISMA are 
introduced. 
 

4.2 Nucleation 
 

Precipitation process starts from the nucleation of clusters that can be considered as embryos of new 
phases with distinctive structures or compositions. In a perfect single crystal, nucleation happens 
homogeneously. In an imperfect crystal or polycrystalline materials, nucleation tends to occur 
heterogeneously due to the presence of dislocations, grain boundaries, edges, and corners. These 
imperfections or defects reduce the nucleation barrier and facilitate nucleation. However, if 
supersaturation or driving force is very large homogeneous nucleation is also possible since all sites 
including those inside a grain can be activated. 
 

4.2.1 Homogeneous Nucleation 
 
The classic nucleation theory (CNT) [3][4] has been extended for the purpose of modeling 

nucleation in multicomponent alloy systems. The time dependent nucleation rate )(tJ  is given by 
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where SJ  is the steady state nucleation rate,  τ  is the incubation time for establishing steady state 

nucleation conditions, and t  is the isothermal reaction time. The steady state nucleation rate SJ  can 

be expressed by  
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where Z is the Zeldovich factor, * is the rate at which atoms or molecules are attached to the 

critical nucleus, 0N  is the number of available nucleation sites (of a particular type) per unit volume, 

*G is the Gibbs energy of formation of a critical nucleus, k is Boltzmann’s constant, and T is 
absolute temperature. In the case of homogeneous nucleation, each atom in the mother phase is a 
potential nucleation site. 
 
The Gibbs energy of formation of a critical nucleus is expressed as 
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where   is the interfacial energy, 
 mG  is the molar Gibbs energy change for the formation of the 

  precipitate of the critical composition 


iX from the   matrix, i.e. the maximum driving force for 

the    phase transformation. 


mV  is the molar volume of the   precipitate phase. The 

maximum driving force 
 mG  and the critical composition 


iX  can be obtained by finding the 

parallel tangent lines or surfaces passing through the alloy composition of the   matrix (see Figure 
2), which is a routine calculation in Thermo-Calc. 
 
Nucleation is a stochastic process and can be considered formally as a diffusion process or Brownian 
movement in the particle size space. Supercritical nuclei with radius slightly larger than the critical 
radius have a probability of passing back across the free energy barrier and dissolve in the matrix. 

The Zeldovich factor Z  is a measure of such probability and is related solely to the thermodynamics 
of the nucleation process: 
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where 
AN  is the Avogadro number and *r , the critical radius, is given by, 
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The atomic or molecular attachment rate *  reflects the kinetics of mass transport in the nucleation 

process and is given by [5] 
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where a  is the lattice parameter, 
 /

iX  and 
 /

iX are the mole fractions of element i  at the interface 

in the precipitate and matrix, respectively. iD  is the corresponding diffusion coefficient in the 

matrix. 
 
The incubation time for an isothermal reaction is 

*2

1




Z
 ,          (7) 

where   differs from one derivation to another. The value 2 from Feder et al. [6] is adopted. 
 

4.2.2 Heterogeneous Nucleation 
 
All equations remain the same for the calculation of heterogeneous nucleation rate within the 
framework of CNT, but the nucleation energy and available nucleation site are different. 
 



To a first approximation, the nucleation energy is calculated by assuming an effective interfacial 
energy for each heterogeneous nucleation site. In future versions of TC-PRISMA, more elaborate 
treatment including grain boundary energy as a parameter will be implemented. 
 

 
Figure 4 Tetrakaidecahedron approximation of grains 

 
 

The number of different nucleation site is dependent on the shape and size of grains in the matrix. 
Assuming all grains are equally large tetrakaidecahedra with the distance between one pair of square 

faces as H, and that between the other two pairs as D (see Figure 2), we obtain the densities 
2 , 

1 , 

and 0  for the grain boundary area, edge length, and grain corner number respectively: 
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where DHA /  is the aspect ratio, defining the degree of elongation of the grains. By default, the 
aspect ratio is set to 1 and the densities are then the same as obtained by Cahn [7]. Once the densities 
are known, if taking boundary thickness as one atomic layer, the available nucleation sites can be 
calculated by 
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where 


mV  is the molar volume of the matrix phase and 
AN  is the Avogadro number. For a 

crystalline material, given a dislocation density d , the number of nucleation sites at the dislocations 

dN can be calculated with the same form,  
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4.2.3. Nucleation during a Non-Isothermal Process 
 
Under a non-isothermal conditions, temperature dependency of key parameters such as nucleation 
driving force, solute diffusivities and solute concentrations, etc., have been taken into account, and 
are updated automatically during a simulation.  
 
Another important parameter that depends on thermal history is the incubation time, defined by Eq. 
(7) for an isothermal condition. In a non-isothermal process, the exact calculation of the incubation 
time requires a solution to the Fokker-Plank equation. In TC-PRISMA, an approximation approach 
has been employed to deal with the transient nucleation, which gives the incubation time as an 
integral form of past thermal history [8] 
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where   is the incubation time, *  is the impingement rate for solute atoms to the critical cluster as 

defined in Eq. (6), and Z  is the Zeldovich factor, previously defined in Eq.(4) but now as a function 

of   derived from temperature change. The starting point of the integral ( 0't  ) is either the 
starting time if there is an initial nucleation driving force, or the latest time when the nucleation 
driving force is vanished. 
 

4.3 Growth 
 
Three different growth rate models have been implemented in TC-PRISMA and they are called 
advanced, simplified, and binary dilute solution models, respectively. 
 
The advanced model is proposed by Chen, Jeppsson, and Agren (CJA) [9] and calculates the velocity 
of a moving phase interface in multicomponent systems by identifying the operating tie-line from the 
solution of flux-balance equations. This model can treat both high supersaturation and cross 
diffusion rigorously. Spontaneous transitions between different modes (LE and NPLE) of phase 
transformation can be captured without any ad hoc treatment. Since it is not always possible to solve 
the flux-balance equations and it takes time when possible, a less rigorous but simple and efficient 
model is preferred in many applications. The simplified model is based on the advanced model but 
avoids the difficulty to find the operating tie-line and uses simply the tie-line across the bulk 
composition.  
 



All models treat a spherical particle of stoichiometric composition or with negligible atomic 
diffusivity growing under the local equilibrium condition. Other precipitate shapes and interface 
conditions (such as para-equilibrium and finite interface mobility) can be considered easily within the 
same approach, which is due to be available in the next version of TC-PRISMA.  
 
The governing equations for the advanced and simplified models are given below. For the binary 
dilute solution model, please see Section 4.8. 
 
According to the CJA model, the interface velocity   can be obtained together with interface 

concentrations by numerically solving 12 n  equations, comprising of the flux balance equations for 

1n  independent components and the local equilibrium conditions for all n  components: 
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where 
 /

ic and 
 /

ic  are the volume concentrations of component i  at the interface in the 

precipitate and matrix, respectively, iM  is the corresponding atomic mobility in the matrix, 
i  and

 /

i  are the chemical potentials in the matrix of the mean-field concentration and at the interface, 

respectively. 
 /

i  is the chemical potential at the interface in the precipitate. In the above local 

equilibrium condition, the multicomponent Gibbs-Thomson effect has been taken into account by 
adding a curvature induced pressure term to the Gibbs energy of the precipitate phase. The 

introduced effective diffusion distance factor, i , for each independent component is given by 
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  is the so-called dimensionless supersaturation for individual component, 

and i  is obtained via the following equation: 

 

    iiiii erfc  
232

exp22        (14) 

 
Combining Eq.(11) and (12), the simplified model can be derived: 
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 and 

/ ( )iX r 
 are simply taken from the tie line across the matrix composition. 

 



The non-zero volume correction to the velocity according to Chen and Voorhees [10] has been taken 
into account and it follows 
 

 ' 1 4 Vr N r       

 

where ’  is the corrected velocity, <r> is the mean radius and VN  is the number density. 

 

4.4 Coarsening 
 
Physically speaking, coarsening or Ostwald ripening where big particles grow and small particles 
shrink is a process driven by lowering the total surface energy of the system. From a thermodynamic 
point of view, the Gibbs-Thomson effect leads to inhomogeneous chemical potentials in the system 
if the particle sizes are not uniform. Solutes at the interface in the matrix near a particle of a radius 
smaller than critical radius will have a higher chemical potential than that corresponding to the mean 
concentration of the matrix. As a result, the solutes will diffuse from the precipitate/matrix interface 
to the inside of the matrix and cause dissolution of the particle. Conversely, particles with radius 
larger than the critical size will have lower interface potentials, and the solutes will diffuse to the 
interface and cause growth of the particles. 
  
Since it is not possible to find a closed form analytic solution for the problem of diffusion-controlled 

spherical particle dissolution [11], we simply apply Eq.11-14 with the absolute value of i to 

calculate the interface velocity for particles of all sizes. As can be easily seen, if *rr  , then the 

Gibbs-Thomson equation, Eq. 12, gives 
  ii /

, and a negative velocity will result from Eq.11 

for particles having *rr  , which means that they will shrink. Results for particles having *rr  will 

be obtained vice versa. In all situations, when the absolute values of  i  are very small, the steady-

state solution for either growth or dissolution will be recovered. In conclusion, we have essentially 
treated dissolution as the reverse of growth [11], and the coarsening shall come out naturally either 
together with nucleation and growth or as a dominant process finally in the course of the evolution 
of the PSD.  
 

4.5 Continuity Equation 
 

Let )(rf be the PSD of a precipitate phase. N - the number of particles per unit volume, r - the 

mean radius. and  - the particle volume fraction,  is expressed as, 
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The time evolution of )(rf follows the continuity equation [1] 
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where )(r  is the growth rate of a particle of size r , and )(rj is the distributed nucleation rate, 

which is defined by 
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where J  is the nucleation rate. 
 
 

4.6 Mass Conservation 
 
The matrix concentration is updated at each time step according to the law of mass conservation. If 

the alloy concentration, i.e. initial mole fraction of component i  in the matrix phase is
0

iX , the new 

concentration iX can be obtained from the following mass balance equation: 
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where ),( trX p

p

i  is the mole fraction of element i  at the interface in the precipitate phase p  of 

particle size pr  at time t . ),( trf p , ),( trp , and 
p

mV  are the PSD function, growth rate, and molar 

volume of the precipitate phase p , respectively. jt  is the time at time step j . Apparently, the new 

matrix concentration, and thus the updated supersaturation, nucleation rate, and interface velocity 
are all functions of the PSD function. This will inevitably lead to the complex non-linear behavior of 
and great difficulty in solving the continuity equation. 
 
 

4.7 Numerical Method 
 
Since it is impossible to have a general close form solution, the complex non-linear continuity 
equation of the PSD function has to be solved numerically. Different numerical methods can be 
found in literature to solve this equation, such as finite difference and method of characteristics. In 
all approaches, the continuous PSD is discretized into a sufficiently large number of size classes, and 
then integrated discretely in the time space. TC-PRISMA utilizes the method of characteristics, 
where the number of particles in each size class is kept constant unless particles of the same size 
have been nucleated.    
 
 
An adaptive geometric grid allocation method has been used for particle size discretization since 
from nucleation to coarsening the particle size can span several orders of magnitude. In this 
approach, the new size grids are allocated evenly in a logarithmic scale and the number of grid points 
over one order of magnitude is kept almost constant during the whole process by class merging and 
splitting. The time step is controlled by several adjustable numerical parameters based on mechanistic 
quantities. Summarised below are all numerical parameters used in this approach to control either the 
size grid distribution or time steps:  
 

 Maximum time step fraction (    
    ) – Maximum time step allowed for time integration 

as fraction of the simulation time. 



 Number of grid points over one order of magnitude in r (     ) – Default number of 
grid points for every order of magnitude in size space. The number determines a default ratio 
between two adjacent grid points. When there is a need to create new grid points, such as 
nucleating at a new radius not covered by the current range of PSD, this default ratio is used 
to add these new radius grid points. A larger value of this parameter enforces a finer grid to 
allow better numerical accuracy. However, this also comes with performance penalty, since 
finer grid in the size space often requires smaller time step to resolve the calculations.  

 Maximum number of grid points over one order of magnitude in r (    
    ) – The 

maximum allowed number of grid points in size space. This parameter determines a lower 
bound limitation for the ratio of every two next nearest grid points in order to maintain 
adequate computational efficiency. When a ratio of two next nearest grid points is less than 
this limit, the middle grid point will be removed and the corresponding size class merged 
with the two neighbouring ones.  

 Minimum number of grid points over one order of magnitude in r (   
    ) – The 

minimum allowed number of grid points in size space. This parameter determines an upper 
bound limitation for the ratio of every two adjacent grid points in order to maintain proper 
numerical accuracy. When a ratio of two adjacent grid points exceeds this limit, a new grid 
point is then inserted between the two adjacent grids to keep the required resolution. 

 Maximum relative radius change (    ) – The maximum value allowed for relative radius 
change in one time step. This parameter limits the time step according to the following 

relation, which is controlled by the particle growth:          |     |  for      , 

where     is a cut-off subcritical size defined by the next parameter. The growth rates of 

supercritical particles (with     ) are always bounded, and there is a size class and the 

corresponding growth rate that controls the time step. The subcritical particles (with     ), 

however, has a mathematical singularity (negative infinity) in growth rate as   approaches 0. 
This means that the time step can become extremely small if applying the above criterion to 
very small subcritical particles. In open literature, several researchers have tried mathematical 
transformation to avoid this singularity. Unfortunately, the transformation also complicates 
the formulation of the models. TC-PRISMA implementation uses a simple approach to deal 

with this issue by defining a cut-off size    . All the particles with       may disappear 

within one time step.     is determined by the next input parameter. 

 Maximum relative volume fraction of subcritical particles allowed to dissolve in one 

time step (      ) – This input parameter represents the portion of the volume fraction that 
can be ignored when determining the time step. It is used to calculate the cut-off subcritical 

size,    , for the above time step control that allows a maximum relative radius changes for 

all particles:  ∫      
   

 
   ∫      

 

 
      . 

 Relative radius change for avoiding class collision (     ) – For the supercritical particles, 
the growth rate is non-linear – usually, it first increases with r and then decreases after a 
certain size. In the region(s) with growth rate decreasing with r, it is possible that the smaller 
size grid point can catch up with the larger size grid, if the time step is not controlled. To 

prevent this from happening, an additional user input parameter,    , can be used to set a 

limit on time step according to the following relation:                          
          for                              . 

 Maximum overall volume change (    ) – This input parameter defines the maximum 
absolute (not ratio) change of the volume fraction allowed during one time step. This 



parameter is also used in controlling allowable variation in volume fraction due to the newly 

created particles within one time step. That is                 
     , where      and 

  are effective radius and nucleation rate, respectively. 

 Maximum relative change of nucleation rate in logarithmic scale (       ) – This input 

parameter ensures accuracy for the evolution of effective nucleation rate. It sets a limit on 
time step so that the relative change of nucleation rate does not exceed the specified value, 

based on the information of previous step. That is                      |           | , 

where nucleation rate    and    occurs at the beginning and end of           . 

 Maximum relative change of critical radius (     ) – During the nucleation under high 
supersaturation, the critical radius can vary dramatically. Hence, this input parameter can be 
used to place a constraint on how fast the critical radium can vary, and thus put a limit on 

time step:                    |             | . 

 Minimum radius for a nucleus to be considered as a particle (       ) – The cut-off 
lower limit of precipitate radius. Particles with radius smaller than the value specified for this 
parameter are discarded. In reality, the particle cannot be smaller than an atom; hence, there 
is no reason to keep track of particles of unphysical sizes. 

 Maximum time step during heating stages (        ) – The upper limit of the time step 
that has been enforced in the heating stages. The current algorithm may over-estimate the 
subsequent time increment when temperature is increased. It is thus required to reduce this 
value when the calculation terminates unexpectedly during or after a heating stage.  

 
The default values for the above numerical control parameters are given in Table 1. 
 
Table 1  Default value for numerical parameters that controls the size grid distribution and time step. 
 

    
           

       
                                          

Default value 0.1 200 300 100 0.01 0.01 0.5 0.001 0.5 0.1 5e-10m 1.0s 

 

4.8 Binary Approximation 
 
Many investigations on precipitation modeling were based on assumptions of stationary growth rate 
and dilute solution in matrix to calculate nucleation and growth rates in binary or pseudo-binary 
systems. It offers a first approximation to the precipitation problem with all necessary model 
parameters calculated analytically if values of the phase boundary, volume, and diffusivity are known 
from any sources.  
 
With dilute solution assumption, the driving force of nucleation is given by 
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and the Gibbs-Thomson equation becomes 
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The growth/dissolution rate of a particle in the steady-state approximation is represented by 
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In addition to the formula given before for the calculation of the attachment rate and incubation 
time Eq. (6-7), other ways were also widely used in many publications. According to Russell [4], the 
attachment rate in a binary system is written as  
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It should be noted that Eq. (6) for multicomponent systems does not reduce to this representation 
for binary systems. The incubation time was first approximated by Kampmann and Wagner [12] as 
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where wc is an adjustable parameter for each particular alloy system and ranges from 1.4 to 3.5. 

Another formula suggested by Wagner and Kampmann [2] is 
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Although these descriptions are not consistent with more rigorous theoretical derivations, they are 
offered as options to choose in the specialized BINARY module due to their acceptance in many 
investigations. 
 

4.9 Estimation of Coherent Interfacial Energy 
 
Interfacial energy is probably the most important parameter in the calculation of rates of nucleation, 
growth/dissolution, and coarsening. Yet, this parameter is also a physical property that is least 
known to everyone so far. As mentioned in the introduction, it is hoped that in future interfacial 
energy can also be modeled in the spirit of CALPHAD method and interfacial energy databases can 
be developed by considering various kinds of experimental data with help of computational tools, 
such as TC-PRISMA. Before this day comes, we have to provide a value for this important 
parameter to conduct precipitation simulations. Since the value of interfacial energy can vary 
dramatically (mostly between 0.01 to 2.0 J/m2) it would be a great help to many users of TC-
PRISMA to have a mean to obtain a rough number to start with. Therefore, an extended Becker’s 
model [13] has been implemented in TC-PRISMA to estimate coherent interfacial energy by using 
thermodynamic data from existing thermodynamic databases:  
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where  c  is the coherent interfacial energy, sn  is the number of atoms per unit area at the interface, 

sz  is the number of cross bonds per atom at the interface, lz  is the coordination number of an atom 

within the bulk crystal lattice, and  sE  is the energy of solution in a multicomponent system 

involving the two phases considered. In the actual calculation, the coefficients taken distinguish 
between only bcc and fcc structure for the (110) and (111) lattice plane respectively. It should be 
emphasized that the method is merely a simple approximation and one should consider it fortuitous 
if the estimated value gives excellent results for precipitation modeling. In most situations, one may 



need to do some adjustment and calibration work on the basis of the estimation. This can be justified 
by the fact that interfacial energy is dependent on so many factors, such as temperature, incoherency, 
orientation, and curvature etc., which have been ignored in the estimation. Since the method is taking 
advantage of the existing databases, the uncertainties of assessed thermodynamic data should also be 
kept in mind in the cautious use of the estimated value for the interfacial energy. 
  



5. Examples 

 

5.1 Al-Sc 
 
This example simulates the kinetics of precipitation of Al3Sc from an Fcc Al solution phase. The 
simulation results can be compared with experimental data collected from E.A. Marquis and D.N. 
Seidman, Acta Mater. 49 (2001) 1909-1919 and G.M. Novotny and A.J. Ardell, Mater. Sci. & Eng.  
A318 (2001) 144-154. The measurements are in seconds and nanometers, respectively. 
 
 

5.2 Cu-Ti 
 
This example simulates the kinetics of precipitation of Cu4Ti from an Fcc Cu solution phase. 
Simulation results can be compared with experimental data collected from R. Wagner and R. 
Kampmann, Homogeneous second phase precipitation, in P. Haasen, editor, Materials Science and 
Technology: A comprehensive treatment, Weinheim, Wiley-VCH, 1991, pp. 213-303. The 
measurements are in minutes and nanometers, respectively. 
 
5.2.1 Use binary dilute solution model 
5.2.2 Use a database package 
5.2.3 TTT calculation 

5.3 Fe-C 
 
This example simulates the kinetics of precipitation of carbides from a Bcc Fe solution phase.  
 
5.3.1 Use binary dilute solution model – two carbides 
5.3.2 Use binary dilute solution model – TTT calculation 
5.3.3 Use a database package 

5.4 Fe-Cr-C 
 
This example simulates the kinetics of precipitation of both stable and metastable carbides from 
ferrite phase. It demonstrates that metastable carbides may first emerge and then disappear, and the 
stable phase will prevail. 
 

5.5 Ni-Al-Cr 
 

This example simulates the kinetics of precipitation of ’ phase from  phase. The simulation results 
can be compared with experimental data collected from C.K. Sudbrack et al., Acta Mater. 56 (2008) 
448-463. The measurements are in hours and nanometers, respectively. 
 



5.6 Non-isothermal 
 

The two examples simulate the kinetics of precipitation of ’ phase from  phase in Ni-8Al-8Cr and 
Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation results can be compared with 
experimental results from T. Rojhirunsakool et al., J. Mater. Sci. 48 (2013) 825-831.  
 
  



6. References 

[1] Langer J, Schwartz A. Phys Rev 1980;21:948. 
[2] Wagner R, Kampmann R. Homogeneous Second Phase Precipitation, in: Haasen P (Ed.). 

Mater. Sci. Technol. Compr. Treat. Weinheim: Wiley-VCH; 1991. 
[3] Kashchiev D. Nucleation. Butterworth-Heinemann; 2000. 
[4] Russell KC. Adv Colloid Interface Sci 1980;13:205. 
[5] Svoboda J, Fischer FD, Fratzl P, Kozeschnik E. Mater Sci Eng 2004;385:166. 
[6] Feder J, Russell KC, Lothe J, Pound GM. Adv Phys 1966;15:111. 
[7] Cahn JW. Acta Met 1956;4:449. 
[8] Jou HJ, Voorhees PW, Olson GB. Computer Simulations for the Prediction of 

Microstructure/property Variation in Aeroturbine Disks, in: Green KA, Pollock TM, Harada 
H, Howson TE, Reed RC, Schirra JJ, Walston S (Eds.). Seven Springs, PA: TMS; 2004. 

[9] Chen Q, Jeppsson J, Agren J. Acta Mater 2008;56:1890. 
[10] Chen MK, Voorhees PW. Model Simul Mater Sci Eng 1993;1:591. 
[11] Aaron HB, Fainstein D, Kotler R. J Appl Phys 1970;41:4404. 
[12] Kampmann R, Wagner R. Kinetics of Precipitation in Metastable Binary Alloys - Theory and 

Application to Cu - 1.9 at% Ti and Ni - 14 at% Al, in: Haasen P, Gerold R, Wagner R, Ashby 
MF (Eds.). Decompos. Alloys Early Stages. Oxford: Pergamon Press; 1984. 

[13] Becker R. Ann Phys 1938;424:128. 
 


